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1.  ES-DMS OVERVIEW 
 

EverSuite Document Management Services Standard Edition (ES-DMS SE) is a plug & play solution installed on 

top of Windows SharePoint Services. 

 

ES-DMS SE installation is run from a single executable setup file. It is installed as a feature in the WSS or 

MOSS site. 

 

ES-DMS SE can be accessed from the Home site or any of its sub sites.  
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2. STEP-BY-STEP GUIDE  

This document serves as a guide using a learn-by-example method involving step-by-step tutoring of all the 

functionalities available throughout the application. 

2.1 LOGIN TO SHAREPOINT 

 

2.1.1 USER PROFILE  

 
A User Profile is personal settings and information about a user that has login access to ES-DMS SE 

application.    

The User Profile contains user related sections like tasks, calendar, settings… A user can customize, operate 

and personalize his sections according to his needs. 

A User accesses different sections and operations in the solution depending on his role and access rights. 

Users access ES-DMS SE using a Web browser, such as Microsoft® Internet Explorer, Netscape Navigator®, 

Mozilla Firefox …  

Users will be provided with an URL to access ES-DMS SE, as well as a user name and password. 

Once the user logs in, his capabilities depend on the permissions and privileges assigned to him by the system 

Administrator(s). 

 

2.1.2 LOG IN  

Like all security context-enabled applications, the user is first presented with a login screen where he/she is 

requested to provide his/her credentials. 

 
 

Upon a successful login, the user is next presented with SharePoint main screen shown below. 
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Once the user clicks on the User Profile menu, a drop down menu will appear as shown above. 

This menu provides sub-sections allowing the user to interact with their profiles’ related operations like 

personal information, personal settings and log out.  

 

 To view/update his information, regional settings, and alerts, the user must click on My Settings. The 

following page will open.  
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 To login with a different account, the user must click on Sign in as Different User. 

 

 To logout of this site, the user must click on Sign Out and the following page will open. The user is 

prompted to confirm his/her sign out request.  

 

 
 
 

2.2 LOGIN TO ES-DMS SE 

 

Users can access ES-DMS SE installed as a WSS site feature from the Site Actions menu. 

 

 
 

The user chooses a site then click Site Actions menu. A drop down menu will appear. 

The user selects EverSuite DMS SharePoint Edition menu and the application home page will open. 
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2.2.1 TOP NAVIGATION MENU 

 

 
 

The upper-side of the screen shows the navigation menu providing the user with straightforward navigation 

links. These menu items are discussed in details later on. 

Navigation Menu is displayed to the user at all times.  

Users can access and use the following Menus according to their privileges. 

Only the Administrator can see the Administration menu. 

 

2.2.2 TABBED MDI INTERFACE 

 

 
 
All operations are performed in a Multiple Tabbed Document Interface. The user does not experience any 

post back operations while interacting with the system. 

 

 

 

2.2.3 USERS’ QUICK LINKS 
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Quick Links allow the users to jump and/or access commonly used sections of the solution: 

 My Home : Opens Home Page. 

 Folder Search : Search for Folders within a selected cabinet or Folder in the Navigation Pane. 

 Add To Favorites : Add a selected folder to the user’s Favorite documents. 

 Raise an Issue : Enables system users to send requests or submit bugs to EVER support team. 

 

2.2.3.1 FOLDER SEARCH  

This section allows the user to search for folders within a selected cabinet or folder in the Navigation Pane. 

The user selects a folder or a cabinet then clicks on Folder Search icon  

 
              
The following search screen will open. 

 

 Search in folder and subfolders: if checked, the user will be able to search in folders and subfolders of 

the selected item, and only content types set as visible will appear in content type restrictions.  
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 Include children content types in search results: if checked, it allows the user to search in the 

children of the selected content type.  

The advanced layout of this section provides the user with many different ways of searching: by 

content type, by name, by type, etc… 

When the user selects a content type, the other search attributes will be filtered accordingly.  

 To perform search, the user clicks the “Search” button  on the toolbar, and the 

results will be listed as shown in the figure below. 

 
 

Search results will appear as a list of links. Once the user clicks on a link, the tree will expand and the 

correspondent folder will be selected as shown below. 

 

 
 

2.2.3.2 ADD TO FAVORITES 

The user selects a folder or a cabinet then clicks on Add to Favorites icon . The following window will 

open asking for the favorite name.  
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The selected folder or cabinet will be added to the favorites. This section will be discussed in details later in 

this manual (section 2.9.1 Favorites). 

2.2.3.3 RAISE AN ISSUE 

To report an issue to EVER’s support team, click on Raise an Issue icon . An empty e-mail will open. 

 

 
 
The email address of EVER’s support team is placed in the 'To…' box. 

The user writes down the error or issue he would like to send then clicks Send.  

Note: “Raise an Issue” must be enabled through the main configuration of the DMS-SE Application. If 

disabled, the users will not see the “Raise an Issue” button  

 

2.2.4 TABBED NAVIGATION INTERFACE 

 
 
 

The Tabbed Navigation Interface provides a tabbed navigation window. This enables users to interact with 

different navigation sections at the same time.   
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2.2.5 NAVIGATION PANE 

 
 

All navigation sections open in the left region of ES-DMS interface.  

Users can select one of the following Tree Views from the tree toolbar: 

 Standard  

 My Folders  

 Advanced 

 View: all created custom trees 

Users can easily explore Trees using the + sign to Expand the Folder and the – sign to Collapse it. 

 

2.2.5.1 STANDARD TREE 

Standard tab opens the standard tree as shown below.  
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2.2.5.2 MY FOLDERS TREE 

My folders tab  opens the tree of the user’s personal folders.  

 

This section will be explained in details later in section 2.3.6 My Folders 

2.2.5.3 ADVANCED  TREE 

Advanced Tree tab opens all web applications trees.  
 
To view a tree, the user must select a web application, a site collection, then a site or a sub site to view the 
correspondent tree as shown below.  
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2.2.5.4 VIEW 

View tab opens a list of the created custom trees as shown in the figure below.  
 

 
 
The user must select one of the created custom trees to view its content as shown below.  

 
 
This custom tree is created by the administrator (Refer to section 3.9 in the Administrator Guide: Manage 

Custom Tree). It contains the values of the properties fields added while creating the tree.  

The user double clicks a content type or a properties field to view the correspondent documents.  
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2.3 MY SITE MENU 

The menu “My Site” visible in the user Top Navigation Menu provides sub-sections allowing the user to 

manage his site’s interface. 

  

This section is divided into the following sub-categories: 

2.3.1 HOME 

Once the user clicks on Home, the menu will expand 

  

 
 

 By clicking on Manage, the following page will open allowing the user to specify the User’s Home 

Page URL.  

 

 
   
 

The user must enter a valid URL then click on . 
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If the User does not specify an URL, the Home Page URL will be the one specified by the Administrator in the 

Site Preference section (described later in the manual).  

 

 By clicking on Open, the home page will open having the URL previously specified in Manage Home 

tab. 

 

This page can also be reached from the Home button  in the Quick Links Toolbar. Section 2.2.3 “Users’ 

Quick Links” 

 

2.3.2 MY TASKS 

 

By clicking on My Tasks the following page will open allowing the user to add/edit/delete tasks. User tasks 

will be listed in a grid, in the bottom of the page. 

 

 
  

 To add a new task, the user simply needs to fill in the task’s fields and then click on Submit button

. 

 Editing an existing task is as easy as adding a new one.  



 

     ES  Content Management  – User Guide 

 

EVER TEAM - Information Owner     Page 18 of 109 

To edit a task, user must click on the Edit button  on the same row of the selected task. The 

screen will show the same fields used for insertion, but this time they will be filled with their existing 

values. User must make his changes and then click on Submit button .  

 

 To delete a task, user must click on the Delete button  on the same row of the selected 

task. The task will be immediately deleted and removed from the task list. 

 

2.3.3 MY ROUTES 

 

By clicking on My Routes, the following page will open allowing the user to view all routes assigned to him.  

(My Inbox and My Outbox) 

  
 

This screen is divided into two sections: the filter area and the inbox and outbox tabs.  

 

2.3.3.1 FILTER  AREA 

The filter area allows the user to filter routes according to criteria entered. The system will only filter the 

selected tab. If the inbox tab is selected the inbox grid only will be filtered.  

 
 

Filter area 

Inbox and 
Outbox area 
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2.3.3.2 INBOX SCREEN  

The inbox screen will display all routes received by the logged in user as shown below.   

 
 
The grid will provide brief information about the route:  From, Purpose, Sent Date, Due Date, … The user will 
have to open the route record to view the remaining information about the route record.  
Four buttons appear in the last column to the right. The functionalities of these buttons depend on the user’s 
rights and permissions: 

• If the user has a read only permission, the document and document properties will open in view 
mode 

• If the user has an edit permission, the document and document properties will open in edit mode 

• If the user has no permission, he will be granted a read only permission once one of these buttons is 
clicked, and the document and document properties will open in read only mode.  

 

 Document : allows the user to open the document routed in view or edit mode according to the user’s 
permission.  

 Document Properties :allows the user to open the doucment properties in view or edit mode according 
to the user’s permission.  

 

Edit View 
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2.3.3.2.1 RESPONSE TO ACTION 

Response to action button  will open a window to view only the route information. Only the comments 
field will be editable as shown in the figure below:  

 

 

The user must add his comments then he may either click on: 

  to save modifications (the status of the selected route is now "In progress") 

   to save modifications and close the route (the status of the selected route is 
now "Closed") 

  to save modifications and reject the route(the status of the selected route is 
now "Rejected") 

N.B: Upon opening the route for viewing, its status will change from New to Opened.  
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2.3.3.2.2 MANAGE ROUTES 

Clicking on Manage Routes  button will open the following page allowing the user to access the document 
route management as shown below:  

 

 

The screen is divided into two sections:  

1- The grid will display all routes related to the parent document of the selected route.  

 

 The user will be able to view the routes properties by clicking on Routes Properties button. 
 

 N.B: only the administrator will be able to delete routes using the delete button  
 

2- The add route form is used to add a new route corresponding to the selected document.  This 
form is visible for users with "Manage Lists" permission. 

 

The user must fill the necessary fields then click on  button to send the route to the selected 
user.  
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2.3.3.3 OUTBOX SCREEN 

The outbox screen displays all routes sent by the logged in user to other users. 

 

 The manipulation is the same as explained above in Inbox screen. The only exception is that the user cannot 

response to action, he can only view the route properties using View Route Properties button .  

 

2.3.4 MY LANGUAGE 

 

Once the user clicks on “My Language”, the menu will expand 

 
 
User then proceeds to select his preferred DMS language display. This selection will affect only the 

correspondent user. 
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DMS French Home Page: 

 
 

 

DMS Arabic Home Page: 

 
 

2.3.5 MY AUDITS 

 
By clicking on My Audits the following page will open allowing the user to view his own audits. 
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This part will be explained in details later in the manual: section 2.11.1 Audit Trail  
 

2.3.6 MY PARAMETERS 

By clicking on My Parameters, the following page will open allowing the user to select the multiple upload 

page mode: SharePoint or Maxim. 

  

This part will be explained in details later in section 2.7.2.2 Adding Multiple Files. 

2.3.7 MY FOLDERS 

Once the user clicks on “My Folders”, the menu will expand allowing the user to set the properties that 

characterize a folder as ‘My Folders’ and \or view My Folders tree.  
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2.3.7.1 MANAGE MY FOLDERS 

Clicking on My Folders  Manage will open the following page allowing the user to set the properties that 

characterize a folder as "My Folders"  

 

 
 
The user must select a content type, and/or add additional criteria in Fields grid to filter the folders 

accordingly then click on submit button .  

The Content Type list is filled with available content types on the current website. When selecting a content 

type, the column ‘Field name will be filled by the fields of the selected content type.  

The column ‘Operator’ will be filled according to the selected ‘Field Name’.  

The folders matching the criteria will be set as My Folders and appear in My Folders tree.  

 

2.3.7.2 VIEW MY FOLDERS 

 
To view my folders tree, the user must click on My Folder  View, or on My Folder tab in the Navigation 

pane. My folders tree will open in the navigation Pane as shown below. 

 
 
In both cases, the user is switched automatically to ‘My Folders’ pane and all folders responding to the 
configuration executed in ‘Manage My Folders’ are available in a tree as first level nodes. 
All subfolders of ‘My Folders’ are available in the tree.  
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All actions (Context Menu Actions and Toolbar actions) are applied to ‘My Folders’ and their subfolders. 
 

2.4 ROOT NODE  

2.4.1 ROOT NODE CONTEXT MENU 

Some of the top navigation menu operations are available in the context menu of the relevant node(s). 

Right click on the root node to view the Context Menu.  

 
 

• Click Add Cabinet to add a new Cabinet. (Refer to section 2.5.1 Adding Cabinets)  

• Click Rename to rename the root node  

 

2.5 CABINET 

 

A cabinet is a location on a site where Files can be created, collected, updated, and managed by Users. 

A cabinet is a collection of many Folders and File types that users can share with team members. 

In a cabinet, the user can perform the following actions:  

• Create and Manage Views 

• Track Versions 

• Check Out Files 

• Stay Informed about changes 

• Define Content Types  

• Require Document Approval 

• Specify Permissions  

• Create Workflows 

 

The menu “Cabinet” visible in the user Top Navigation Menu provides sub-menus allowing the user to 

add/delete/rename/ Cabinets, view Cabinet’s documents and manage Cabinet’s permissions and settings. 
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2.5.1 ADDING CABINETS 

This section allows the user to add a new Cabinet.  
 

 
To add a new Cabinet the user selects the root node from the tree then click the “Add” button 

 in the cabinet menu, or click on Add Cabinet  in the root node right click 

menu. He/she will be presented with a new form asking for details about the new Cabinet as shown below. 

 

 
 

The user must: 

 Enter the name of the cabinet he wants to add 

 Specify whether to allow the management of content types on this document library 

 Specify whether a version is created each time you edit a file in this document library 

 Specify whether users must check out documents before making changes in this document library 

 Click on Submit button . The Cabinet will be added to the tree in the Navigation Pane.  

2.5.2 DELETING CABINETS 
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The user must choose a cabinet from the tree in the navigation pane then press the Delete button 

 in the cabinet menu. The cabinet will be deleted after a confirmation message. 

 

Deleting a Cabinet will result in deleting all its content; Folders and Documents. 

 

A deleted cabinet is sent to the recycle bin; administrators can either restore or delete the cabinet 

permanently.  

 

2.5.3 RENAMING CABINETS 

 

The user must choose a cabinet from the tree in the navigation pane then press the Rename button 

 in the cabinet menu to rename the selected cabinet.  

 

2.5.4 VIEWING CABINETS’ DOCUMENTS 

 

To view cabinet’s documents, the user must either double click on the cabinet name or choose a cabinet 

from the tree in the navigation pane then press the View Documents button  in the 

cabinet menu.  

 

The list of the cabinet associated documents will open in the services pane.  

 
 

When specifying a view for the document library in SharePoint, the user must specify whether to show all 

items in the cabinet including the documents in folders and subfolders, or to show items inside folders only.  

 

In case the checkbox Include the subfolder’s documents is checked, all documents in the cabinet folders and 

subfolders will appear. Otherwise, only the documents of the selected cabinets will appear.  
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The user can also specify the groups and subgroubs as well as the order in which the items are displayed.  
 

 In the Sort section, the user can choose whether and how he wants the information to be sorted. He can 
use two columns for the sort. 

 
 

 In the Group By section, the user can group items with the same value in their own section. 

 
 
 

2.5.5 CABINET PERMISSIONS 

This section manages the user’s permissions on the selected cabinet. This section allows the user to 

add/edit/delete permissions on the selected cabinet.  

2.5.5.1 ADDING CABINET PERMISSION 

To add a cabinet permission, the user must choose a cabinet from the tree in the navigation pane then press 

the Permissions button  in the cabinet menu and the following page will open. 
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The user must select users or groups, select Permission level and then click on  button to save the 

assigned privileges.  

He can enter the users or groups to which he wants to give permission or search for people or groups from 

the SharePoint site by clicking on browse button. The following page will open. 

 

 
 

The user is requested to type a name to find, select the name or names in the result list and then click Add.  
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2.5.5.2 DELETE CABINET PERMISSIONS 

The user must select privileges from the grid then click on  button to remove assigned privileges. 

 

2.5.5.3 INHERIT PERMISSION  

By default, cabinets inherit permissions from their parent sites. Once the user clicks on 

button, the following window will open with a message on top “The current object inherit permissions from 

its parent” 

 
              
Once the user changes permission, inheritance will be broken and the permission page will show the 

following message “The current object has unique permissions” and the Inherit Permissions button  to 
restore inheritance.  
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2.5.6 CABINET SETTINGS  

To manage cabinet settings, the user must choose a cabinet from the tree in the navigation pane then click 

the Settings button  in the cabinet menu and the following page will open. 

 

 
 

The user will be able to manage the cabinet settings already created filled in Add Cabinet window.  
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2.5.7 CABINET CONTEXT MENU 

Some of the top navigation menu operations mentioned above is also available in the context menu of the 

relevant node(s). 

Right click on a Cabinet to view the Context Menu.  

 

   
 

• Click AddFolder to add a new folder to the selected Cabinet.  

• Click Add Pattern to add the selected pattern under the selected cabinet. (For more information 

refer to section 2.12.1 Pattern) 

• Click Add Structure to add a new structure to the selected Cabinet. (Refer to section 2.5.7.2 Add 

Structure)  

• Click Delete to delete the selected Cabinet. 

• Click Delete Query to delete the query (created by the administrator). 

• Click Send ToPaste to paste a cut or copied Folder into the selected Cabinet (described later in the 

manual).  

• Click Send ToPaste Shortcut to create a shortcut of a copied Folder into the selected Cabinet 

(described later in the manual). 

• Click View Documents to view the selected Cabinet’s documents. 

• Click EditNavigation Form to navigate through the correspondent Cabinet documents. (For more 

information refer to section 2.5.7.3 Cabinet Navigation Form) 

• Click EditRename to change the name of the selected Cabinet. 

• Click ManagePermissions to manage the cabinet permissions. (Already explained in section 2.5.5 

Cabinet Permissions) 

• Click ManageSettings to manage the cabinet settings. (Already explained in section 2.5.6 Cabinet 

Settings) 

• Click ManageContent Types to manage the cabinet content types. (For more information refer to 

section 2.5.7.1 Manage Content type) 

• Click Desktop Shortcut to create a shortcut of the selected cabinet on the desktop. 

• Click Window Explorer to open the selected cabinet in windows explorer view. 
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2.5.7.1 MANAGE CONTENT TYPES 

Manage Content Types appears only for users with specific permissions allowing them to update content 

types. It allows the user to set the default content type and to control the visibility of content types as shown 

below.  

 

In case a document library does not allow management of content types, the following page will open asking 

the user to contact the system administrator.  

 

2.5.7.2 ADD STRUCTURE  

Add Structure opens the following page allowing the user to add a new structure.  

 

 

The user selects a query (already created by the administrator) then click on Submit button  to 
execute the query. A new structure will be added according to the selected query as shown in the figure 
below.  
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To add the structure folders to the tree as SharePoint folders, right click a folder, the following menu will 
appear.  

 

 Clicking on Add will add the selected folder with its parent. 

 Clicking on Add with children will add the selected folder with its parent and its children.  

 

N.B: If the structure is added to the root node, its parent node will be a cabinet.  
         If it is added to a cabinet, its parent node will be a folder.  
         If it is added to a folder, its parent node will be a folder.    

 

2.5.7.3 CABINET NAVIGATION FORM 

Navigation Form allows the user to navigate throughout the correspondent Cabinet’s documents according 

to conditions and priorities predefined by the administrator in the Configuration tab of the Administration 

menu. The restrictions of this configuration appear on top of the Navigation Form. Users can perform general 

functionalities in Navigation Form such as viewing Images, PDF Files, etc… and updating the correspondent 

file properties. 
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The Navigation Form will display the Documents to the user(s) based on the following criteria: 

 File is not checked out by any user 

 File is checked out by the currently logged in user 

 File matches the filter(s) applied by the Administrator 

 File is on top of the Priority list 
 
Once the user opens a File through the Navigation Form the file will be automatically Checked-out to the 
correspondent user. After either submitting the changes or closing the Navigation Form, the file will be 
released from the user via a Check in or a Discard Check Out. 
 

The split button  allows the user to create copies of the displayed document in the selected cabinet. 
The created documents will be checked out by the logged in user.  

The number of copies will be indicated in the following field which 
appears once the split buton is clicked.  
 The first copy of a document is «_ 1 », and then it is increased by one. 
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2.6 FOLDER 

The menu “Folder” visible in the user Top Navigation Menu allows the user to manage folders. 

 

This menu is divided into the following sub-menus:  

 Add Folder: to add a new folder. 

 Delete: Delete the selected Folders. 

 Rename: Rename the selected Folders. 

 Edit: Edit operation on the selected folder including. 

 Cut 

 Copy 

 Paste 

 Paste Shortcut  

 Manage Content Types to manage the folder content types. 

 Links: view folders linked to the selected folder 

 Properties: View or Edit the selected Folder’s Properties. 

 View Documents: Display the selected Folder’s documents. 

 Permissions: Manage Users permissions on the selected Folder.  
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2.6.1 ADDING FOLDERS 

To add a new Folder, the user selects a folder or a cabinet from the tree then click on “Add” button 

 in the folder top navigation menu or in the folder or cabinet right click menu. 

The user will be presented with a new window asking for the folder name as shown below. 

 

 

Once the user clicks on the link , the link will expand asking for details about the 

new added folder as shown below.  

 
 

Folder content type will appear by default. The user may select another content type from the drop 

down list. Only content types set as visible will be shown in the drop down list.  

The user may select a pattern (optional). The following grid will appear in the lower part of the page.  

The selected pattern is already created by the administrator (for more information refer to Add new 

pattern in ES-DMS administrator guide) 

 

Once all mandatory fields are filled click on  button.  
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The new folder and its subfolders will appear in the Navigation Pane according to the selected 

pattern.  

 
 

2.6.2 DELETING FOLDERS 

 

The user must choose a folder from the tree in the navigation pane then press the Delete button 

 in the folder menu. The folder will be deleted after a confirmation message. 

 

Deleting a Folder will result in deleting all its content, Subfolders and Documents. 

 

A deleted Folder is sent to the recycle bin; administrators can either restore or delete the Folder 

permanently.  

 

2.6.3 RENAMING FOLDERS 

 

The user must choose a folder from the tree in the navigation pane then press the Rename button 

 in the folder menu to rename the selected folder.  

 

2.6.4 MANAGE CONTENT TYPES 

Manage Content Types appears only for users with specific permissions allowing them to update content 

types. It allows the user to set the default content type and to control the visibility of content types as shown 

below.  
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By default, folders inherit visibility settings from their parent folder as appears in the message on top “This 

folder inherits visibility from its parent folder”.  

Once the user changes content type settings, inheritance will be broken, and manage content types page will 

show the following message “This folder has unique visibility settings” and the link to restore 

inheritance. 

 

In case the parent document library does not allow management of content types, the following page will 

open asking the user to contact the system administrator to manage content types.  

 

 

2.6.5 EDIT OPERATIONS 

The section “Edit” visible in Folder menu provides sub-sections allowing the user to cut/copy/paste/paste 

shortcut of a selected folder.   
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2.6.5.1 CUT, COPY AND PASTE 

 

To cut or copy a folder, the user must select follow the following steps: 

 Select a folder from the tree in the navigation pane  

 Click on Edit button in the folder menu 

 Select Cut to cut the selected Folder, or Copy to make a copy 

 Select the destination Folder or Cabinet in the navigation pane  

 Click on Paste 

  

Cut or Copied Folders will be added under the destination Folder or Cabinet.  

 

If the operation was “Cut”, the Folder will be deleted from its original location. 

If the operation was “Copy”, the Folder will remain in its original location.   

 

2.6.5.2 COPY AND PASTE SHORTCUT 

To copy a folder, the user must choose a folder from the tree in the navigation pane then press Edit → Copy 

in the folder menu.  

 

The user is prompted to select the destination Folder or Cabinet in the navigation pane and click on Paste 

Shortcut from the Folder menu Edit. 

  

A shortcut of the copied Folders will be added under the destination Folder or Cabinet. 

 

To find the original folder of a shortcut folder, the user right-clicks a shortcut folder then clicks on Go To 

Original Folder.  

 
 
The original Folder will be selected as shown below: 
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The user can also view the Original Folder by clicking on . The properties of the original 

folder will open.  

To delete the shortcut the user must click on . 

 

2.6.6 LINKS 

 

To view the folders linked to the selected folder, the user must select a folder then click on Links and the 

following page will open. 

 
 

The Links grid shows a list of folders linked to the selected folder.  

 

View Links button  will display the folders linked to the correspondent folder allowing the user to add new 

links. 

To add a new link the user must click on  button. The Add Links frame will open in the bottom of the 

page allowing the user to search for folders to be linked to the selected folder.  
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The user must enter search criteria then click on Search button. The search results will appear as follows.  

 
 

N.B: only folders having the same content type as the selected folder will appear in search results. 
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The user must select the folder(s) to be linked then click on Submit button.  

Once the user clicks on any link, the tree will expand and the correspondent folder will be selected as shown 

below. 

 

 
 

To remove a document link, the user must select a link then click on button. 

 

2.6.7 FOLDER PROPERTIES 

The section “Properties” visible in Folder menu provides sub-sections allowing the user to view/edit the 

properties of a selected folder.   

 

 
 

2.6.7.1 VIEWING 

In this section, the user can view the properties of the selected folder.  

The user must choose a folder from the tree in the navigation pane then press the View button 

 in the Folder Properties menu. 

The page will display the properties of the selected Folder in read only mode. 

The user can only view the properties but he cannot edit them. 

 
 
Upon clicking “Cancel” button, the properties page closes. 
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2.6.7.2 EDITING 

In this section, the user can edit the properties of the selected folder.  

The user must choose a folder from the tree in the navigation pane then press the Edit button 

 in the Folder Properties menu. 

The page will display the properties of the selected Folder in edit mode. 

 

 
 
 

The user must add the necessary changes then click on “Submit” button, to save the changes.  

 

2.6.8 VIEWING FOLDERS’ DOCUMENTS 

 

To view the documents of a selected folder, the user must simply double click on the folder name or choose a 

Folder from the tree in the navigation pane then press the View Documents button  in 

the folder menu. 

 

The selected Folder’s document tab will appear. 
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2.6.9 FOLDER PERMISSIONS 

 
The section “Permissions” visible in Folder menu provides sub-sections allowing the user to add/edit/delete 

permissions of a selected folder.   

 

2.6.9.1 ADDING PERMISSION 

 

To add a folder permission the user select a Folder from the tree in the navigation pane then press the 

Permissions button  in the folder menu and the following page will open. 

 

 
 

The user must select users or groups, select Permission level and then click on  button to save the 

assigned privileges.  

He can enter the users or groups to which he wants to give permission or search for people or groups from 

the SharePoint site by clicking on browse button. The following page will open. 
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The user is requested to type a name to find, select the name or names in the result list and then click Add.  

2.6.9.2 DELETE FOLDER  PERMISSION 

The user must select privileges from the grid then click on  button to remove assigned privileges. 

 

2.6.9.3 INHERIT PERMISSION  

By default, folders inherit permissions from their parent cabinets. Once the user clicks on 

button, the following window will open with a message on top “The current object inherit permissions from 

its parent” 

 
         

 
Once the user changes permission, inheritance will be broken, and the permission page will show the 

following message “The current object has unique permissions” and the Inherit Permissions button  to 
restore inheritance.  
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2.6.10 FOLDER  CONTEXT MENU 

Some of the top navigation menu operations mentioned above is available in the context menu of the 

relevant node(s). 

Right click the Folder to view the Context Menu. 

  
 

• Click AddFolder to add a new Subfolder. 

• Click AddPattern to add the selected pattern under the selected folder. (For more information 

refer to section 2.12.1 Pattern) 

• Click AddStructure to add a new structure to the selected folder. (Refer to section 2.5.7.2 Add 

Structure) 

• Click Delete to delete the selected Folder.  

• Click Delete Query to delete the query (created by the administrator) 

• Click Send ToCut to cut the selected Folder.  
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• Click Send ToCopy to copy the selected Folder.  

• Click Send ToPaste to paste a cut or copied Folder into the selected Folder.  

• Click Send ToPaste Shortcut to create a shortcut of a copied Folder into the selected Folder.  

• Click View Documents to view the selected Folder’s documents. 

• Click EditProperties to edit the properties of the selected folder. 

• Click EditNavigation Form to navigate through the correspondent folder. 

• Click EditRename to change the name of the selected Folder. 

• Click ManagePermissions to manage the folder permissions. (Already explained in section 2.5.5 

Folder Permissions) 

• Click ManageContent Types to manage content types. This part is already explained in section 

2.6.4 Manage Content Types. 

• Click ManageLinks to view the folders linked to the selected folder. 

• Click Desktop Shortcut to create a shortcut of the selected Folder on the desktop. 

• View properties 

• Click Window Explorer to open the selected folder in windows explorer view. 

 

2.6.10.1 FOLDER NAVIGATION FORM 

Navigation Form allows the user to navigate throughout the correspondent Folder’s documents according to 

conditions and priorities predefined by the administrator in the Configuration tab of the Administration 

menu. The restrictions of this configuration appear on top of the Navigation Form. Users can perform general 

functionalities in Navigation Form such as viewing Images, PDF Files, etc… and updating the correspondent 

file properties. 

 

 
The Navigation Form will display the Documents to the user(s) based on the following criteria: 
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 File is not checked out by any user 

 File is checked out by the currently logged in user 

 File matches the filter(s) applied by the Administrator 

 File is on top of the Priority list 
 
Once the user opens a file through the Navigation Form, the file will be automatically Checked-out to the 
correspondent user. After either submitting the changes or closing the Navigation Form, the file will be 
released from the user via a Check in or a Discard Check Out. 

The split button  allows the user to create copies of the displayed document in the selected folder. 
The created documents will be checked out by the logged in user.  

The number of copies will be indicated in the following field , which 
appears once the split button is clicked.  
The first copy of a document is «_ 1 », and then it is increased by one. 
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2.7 DOCUMENT MANAGEMENT 

The menu “Document” visible in the user Top Navigation Menu allows the user to manage documents. 

  
                

This menu is divided into the following sub-menus:  

 Add: Upload a File or Multiple Files, or Scans Files to the selected folder. 

 New: Create a new File, based on a pre-defined template. 

 Delete: Delete selected documents. 

 Shortcut: Create shortcuts of the selected documents in different containers (Folders or Cabinet). 

 Edit: Copy or Move the selected documents to different containers (Folders or Cabinet). 

 Properties: View/Edit properties of the selected document. 

 Send by Email: Send the documents by Mail as a link or attachment.  

 Electronic deposit: Add the selected document to electronic deposit. 

 

2.7.1 VIEWING DOCUMENTS 

The Documents and Services Frame displays a list of all the documents of a selected folder or cabinet. 

 

 
 

Fields Displayed in the List Including Document Type, Name, etc…, are all attributes defined in the selected 

view.  
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2.7.1.1 MANAGE VIEW LIST 

The user can create a new view, select or modify an existing one.  

 

 
 

 The user selects a view from the View drop down list. 

 

 A new view can be added by simply clicking on Create View in View dropdown list. A new form pops 

up allowing the user to enter the name of the new view, select the columns and their positions, check 

“Make this the default view” checkbox to set the new created view as default. 

Upon clicking on Submit button the created view will be saved.  

 

 

 

 To modify an existing view, the user simply selects the view he wants to modify, then clicks on 

Modify View from View dropdown list. The screen will show the same fields used to add a new view, 

but this time they will be filled with their existing values. 

 

 
  

 The user is prompted to click on  button to save the modifications.    
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2.7.1.2 SORTING AND GROUPING DOCUMENTS 

 

To Group documents, the user must drag a header column and drop it where the red arrows show, to group 

the files by that columns. 

 

 

 
  

 

Ex: Files will be grouped by name as shown below. 
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2.7.2 ADDING DOCUMENTS 
 

The section "Add" visible in Document menu provides sub-sections allowing the user to add one or 

multiple documents or to scan documents.   

 

 

    

 

                                

 

2.7.2.1 ADDING FILE 

To add a new file, the user must select a folder or a cabinet from the tree in the navigation pane, 

then click on Add →File in the document menu, and the following page will open. The user will be 

presented with a new form asking for details about the new file as shown below. 

 

 
 

The user must browse for the document then click submit . 

 

 If the parent Cabinet or Folder allows versioning, users cannot overwrite existing Files; they 

can only choose to upload a new version of the document.   

 
 If the parent Cabinet or Folder does not allow versioning, users can choose to overwrite 

existing File. 

 
 If a File with the same name exists in the Folder and the overwrite option is not checked, 

then an error message will be displayed. 

 
 

In Private File section, the user must specify whether he wants to upload a private file by user or by 

user and group.  
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 None: the file will be viewed by all users and groups 

 By user: only the logged in user will be able to view this file 

 By User and Group(s): only users belonging to the same group of the logged in user will be 

able to view this file   

Once the Document is added, the property window will be displayed to the User to fill in the 

attributes (properties) of the document. 

The user is first prompted to select a content type, and then click on  button. Notice how 

the document properties are filtered according to the content type selected.  

 

 

 Clicking on Submit, will save the properties assigned to this document 

 Clicking on Cancel will close the File Properties window (The file will remain in the list of 

documents, but with no properties assigned to it) 
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 Clicking on Reset will reset the columns to their default value (Often blank) 

 

2.7.2.2 ADDING MULTIPLE FILES 

To add multiple files, the user must select a folder or a cabinet from the tree in the navigation pane, 

then press the Add →Multiple in the document menu, and the following page will open. The user 

will be presented with Upload Multiple Tab. 

 

 
 

The user can close this tab by clicking on Cancel or on the Tab’s close button. 

To upload documents, the user must click on Browse to navigate to the desired directory then click 

OK.  

 
 

The user will be presented with a new form listing the documents of the selected directory as shown 

below. The user is prompted to select the documents he needs to upload then click on Upload 

button.  
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A message will appear notifying the user of the files uploading status once the operation finishes. 

 

 
 

Uploaded documents will be added to the Cabinet’s/Folder’s Documents.  

 

2.7.2.3 SCAN 

To scan a file, the user must select a folder or a cabinet from the tree in the navigation pane, then 

press the Add →Scan in the document menu, and the following page will open. 
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The user selects one or multiple scanned images to be uploaded to the selected folder.  

The user can choose to upload selected image(s) as one PDF file by checking the Upload selected 

images as one PDF file checkbox and\or set the file as private file by checking Private file checkbox.  

The user can also check the Overwrite/Add as a new version to existing files checkbox in order to 

overwrite/add a new version to existing files having the same name as the uploaded ones. 

The user can delete selected images by clicking delete button . 

 

2.7.2.4 NEW DOCUMENT 

 

 ES-DMS SE integrates closely with Microsoft Office suite applications. 

 It provides users with complete interaction features with ES-DMS SE without leaving the 

Microsoft Office suite applications. 

 It provides users with enhanced navigation, in-browser rendering and sometimes editing of 

Microsoft Office documents. 

 It provides users with a two-way synchronization with collaborative information, documents, 

and business data stored.  

 

To add a new document, the user selects a folder or a cabinet from the tree then click the “New” 

button in Document menu. The user will be presented with a new window asking for the content 

type group and the content type of the new document as shown below.  

 

 

The user selects a content type from the drop down list then click on submit . 

 If the selected content type doesn’t have any template, a new word document will open as 

shown below: 
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The user may enter the necessary information then click on Save button  to save the changes. The 

following window will open:  

 

 

1. The user must select the URL of ES-DMS (SE) WSS Parent Site. The list of Document Cabinets 

will be filtered in order to match the selected site.  

2. The user must select the Document Cabinet in which he wants to save the Document.  

3. The user must enter the File name in the correspondent field then click Save button. 
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 If the selected content type has a special page, a new word document will open with the 

correspondent template:  

 

The user may enter the necessary information then click on Save button  to save the changes. The 

document name will be saved under the following format: Content Type name_Date_Time as 

follows  

2.7.3 DELETING DOCUMENTS 

To delete a document, the user must select one or more documents then click on Delete button 

  in Document menu. The selected document(s) will be deleted after a confirmation message. 

 

A deleted Document is sent to the recycle bin; administrators can either restore or delete the Document 

permanently.  

2.7.4 SHORTCUT 

To create a Shortcut, the user selects one or more files then click Shortcut button  in 

Document menu. The user will be presented with the following window. 
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The user must select the destination Folder or Cabinet for the shortcut, then click upload. 

A message will appear showing if the shortcut was created successfully or not.  

 

 
      
 

Shortcut documents will be created in the destination document. 

 

2.7.4.1 FIND TARGET 

To view the original document, the user right clicks a shortcut, then click on . 

 

 
     
The Document tab of the original Document will open.  Only the original Document will appear. 

 

 
 

To view all files, the user clicks on the link  on the bottom of the page.             
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2.7.5 EDIT OPERATIONS 

The section “Edit” visible in document menu provides sub-sections allowing the user to copy/move a selected 

folder.   

 

 
 
 

2.7.5.1 MOVING DOCUMENT 

To move a selected document, the user selects one or more Documents then clicks on Edit → Move button

 in the Document menu. The following page will open.  

 
 

The user chooses the destination Folder or Cabinet to which he wants to move the document(s) from the 

Standard tree, My Folders tree or Favorites tree then click on Upload.  

 

Users can choose to overwrite (or create a new version of) the Document(s) if it already exists in the new 

Folder by checking the correspondent checkbox. 

 

To search for a specific folder in any tree the user must use the search toolbar on top of Move window:  

 

1- Select a content type 

2- Enter the search criteria in search field 

3- Click on  

Folder search results will appear selected in the correspondent tree, and the number of returned results 

appears in the search toolbar.  
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The user can move from one folder to the next one through the blue arrow . 

N.B: Once moved to its new (destination) location, the Document will be removed from its original location. A 

message will appear showing if the document was moved successfully or not. 

 

 

2.7.5.2 COPYING DOCUMENT 

Copying a Document is the same as moving it, except that it will not be removed from its original location. 

Refer to Section 2.7.6.1: “Moving Document” for detailed instructions.    

 

 

2.7.6 DOCUMENT PROPERTIES 

The section “Properties” visible in Document menu provides sub-sections allowing the user to view/edit the 

properties of a selected document.   

 
 

2.7.6.1 VIEW FILE PROPERTIES 

The user must select one or more documents having the same content type then click on View button 

 in the document Properties menu. 

A View Properties window will display in read only mode.  

 
 

Two returned 
folders 
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In case more than one document having the same content type are selected, the following page will open. 

The user must click on one of the icons in view column to view the document properties.  

 

 
 

2.7.6.2 EDIT FILE PROPERTIES 

In this section, the user can edit the properties of the selected document.  

The user must selects one or more files having the same content type then click the Edit button 

 in the document Properties menu. 

If one document is selected, the page will display the properties of the selected document(s) in edit mode. 

 

 
 
In case more than one document having the same content type are selected, the following page will open.  
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The user can add the necessary changes and the checked fields will be saved upon clicking on “Submit” 

button.  

 

2.7.7 SEND BY EMAIL 

To send a document by mail, the user must simply select one or more documents then click on Send by Email 

button   in the document menu. 

 

The following page will open. 
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The user must enter the Email addresses and the subject of the email, and then choose to send the selected 

files as Links or as Attachments and finally click Send.  

 

2.7.8 DOCUMENT SERVICES 

Once the user right clicks on a document row, the Document Services drop down menu will appear. 

 

 
  
 

This section is divided into the following sub-categories:  

 Add to: 

o Electronic deposit 

o Favorites  

 Conversion 

 Delete  

 Edit: 

o Check out 

o Document  

o Properties 

o Image viewer 

 Manage: 

o Links \ Related Formats 

o Permissions 

o Routes 

 View: 

o Audit Trail 

o Properties 

o Version history 

 Send to: 

o Copy 
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o Download a copy 

o Move  

o Shortcut  

 Send by mail 

 Workbook: 

o Transform 

o Mark to import 

2.7.8.1 ADD TO ELECTRONIC DEPOSIT  

The Electronic deposit feature is used to allow users to send by mail several selected documents located in 

different locations (document libraries or folders).  

 

Use the document context menu Add toElectronic deposit to add the selected document to the electronic 

deposit of the current user. 

The user can manage documents in the Electronic deposit in the Services menu, Manage Electronic Deposit. 

(Managing Electronic Deposit will be explained in details later in this document. Refer to section 2.12.4 

Manage Electronic Deposit) 

 

2.7.8.2 ADD TO FAVORITES 

To add a selected file to the user’s favorite documents, the user must click on Add toFavorites in the 

document context menu. 

If the selected item already exists, the following message will appear.  

 

 

Viewing Favorites will be explained in details further in the manual course. Refer to section 2.9.1 Favorites for 

detailed instructions. 

2.7.8.3 CONVERT 

Convert option is only available for specific document types in the document’s context menu. To convert a 

selected document, the user must click on , the following conversion window will open. 
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The user must select the type to convert to from the drop down list filtered as follows: 

 World document can be converted to Text document or PDF document 

 Excel document can be converted to PDF document 

 PDF document can be converted to Word document  

 Text can be converted to Word document and PDF document 

He may also select to view or to save the converted document.  

Clicking on  button will convert the document to the selected type. 

2.7.8.4 DELETE 

To delete a document, the user must select an item then click on Delete in the document right click menu. 

The document will be deleted after a confirmation message.  

2.7.8.5 EDIT CHECK OUT – CHECK IN 

To prevent other users from editing a document, the connected user must click on EditCheck Out.  

Some cabinets force documents’ Check Out. Documents in those cabinets/folders should be checked out by 

users before being edited.  

After check out, the user can Check In to release the file and save the changes, or Discard Check Out to 

release the file and discard changes. 

2.7.8.6 EDIT EDIT DOCUMENT  

To open a document for editing the user must click on EditEdit Document. The document will open in edit 

mode. 

 
 
To view and edit the document properties, the user must click on Properties as shown in the figure below.  
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The properties of the selected document will appear in edit mode on top of the page.  

 
 
 

The user can make the necessary modifications to the selected document then click on save to save the 

changes.  

 

2.7.8.7 EDIT PROPERTIES 

In this section, the user can edit the properties of the selected document.  

The user must select a document then click on Edit Properties in the document context menu. 

The following page will open showing the properties of the selected document in edit mode. 

 

 
 
The user can add the necessary changes then click on “Submit” button to save the changes. 

 

2.7.8.8 EDITIMAGE VIEWER 

The Image Viewer opens Images and AutoCAD files in the built in image viewer of the System. 

Image Viewer will be explained in details further in the Manual Course.  

Refer to Section 2.8: “Advanced Imaging Services” for detailed instructions. 
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2.7.8.9 MANAGELINKS \ RELATED FORMATS  

To view the links \ related formats of a document the user must select a document then click on 

ManageLinks\Related Formats and the following page will open. 

 

 
 

The Links \ Related Format grid shows a list of the Documents linked to the selected document.  

 

To add a new link the user must click on  button. The Add Links frame will open in the bottom of the 

page allowing the user to search for a document to be linked to the selected document.  

 
The user must:  

 Enter search criteria  

 Click on Search button 

 Select the document(s) to be linked  

 Click on Submit button 

The submitted document(s) is now linked to the parent document. 

To remove a document link, the user must select a link then click on button.  

 

2.7.8.10 MANAGE PERMISSIONS 

2.7.8.10.1 ADDING PERMISSION 

 

To add document permission the user select a document then click on ManagePermissions. The following 

page will open. 
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The user must select users or groups, select Permission level and then click on  button to save the 

assigned privileges.  

He can enter the users or groups to which he wants to give permission or search for people or groups from 

the SharePoint site by clicking on browse button. The following page will open.  

 

 
 

The user is requested to type a name to find, select the name or names in the result list and then click Add.  

2.7.8.10.2 DELETE PERMISSION 

The user must select privileges from the grid then click on  button to remove assigned privileges. 
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2.7.8.10.3 INHERIT PERMISSION  

By default, documents inherit permissions from their parent cabinets. Once the user clicks on 

button, the following window will open with a message on top “The current object 

inherit permissions from its parent” 

 

 
         
Once the user changes permission, inheritance will be broken, and the permission page will show the 

following message “The current object has unique permissions” and the Inherit Permissions button  to 
restore inheritance.  

 

 
 

2.7.8.11 MANAGE ROUTES 

Once the user clicks on ManageRoutes in the document right click menu, the following page will open 

allowing the user to manage the routes of the selected document.  
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The manipulation is the same as explained above in section 2.3.3.2.2 Manage Routes 

2.7.8.12 VIEWAUDIT TRAIL 

Audit Trail will appear in the document right click menu only when this document is created by the logged in 

user. Once the user clicks on View Audit Trail, the following window will open allowing him to view the 

audit trail of the selected document.   

 
This grid displays the modifications that occurred to selected Documents including routes. 

The upper frame of the window allows the user to filter Audit results according to the criteria entered. 

Routes will appear in filter results only when the Action Type is Route Actions.  

2.7.8.13 VIEWPROPERTIES 

The user must select one or more documents having the same content type then click on ViewProperties 

in the document context menu. 

A View Properties window will display in read only mode.  
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2.7.8.14 VIEWVERSION HISTORY 

To view the Version History the user must click on ViewVersion History. The following page will open. 

 

 
 
The Version History grid shows a list of the versions of the selected Document.  

 To open a selected version the user must click on the correspondent link in File Name column.  

 To view version properties the user must click on the correspondent icon in View Properties column.  

 To delete a version the user must click on Delete.   

 To delete all versions the user must click on  

 

2.7.8.15 SEND TO COPY 

To copy a selected document, the user selects one or more Documents then clicks on Send toCopy in the 

document context menu. The following page will open.  

 
The user chooses the destination Folder or Cabinet to which he wants to copy the document(s) then click 

Upload.  

Users can choose to overwrite (or create a new version of) the Document(s) if it already exists in the new 

Folder by checking the correspondent checkbox. 

  

N.B: Once copied to its new (destination) location, the Document will remain in its original location. 
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2.7.8.16 SEND TO DOWNLOAD A COPY 

Once the user clicks on Send ToDownload a Copy, the following window will open allowing him to open 

the document or save a copy locally.  

 
 

 

2.7.8.17 SEND TO MOVE 

Moving a document is the same as copying it, except that it will be removed from its original location. 

Refer to section 2.7.9.15: Send to  Copy for detailed instructions. 

 

2.7.8.18 SEND TOSHORTCUT 

The user must choose one or more documents then click on Send ToShortcut in the document context 

menu and the following page will open. 

 
 
The user must select the destination Folder or Cabinet for the shortcut, then click upload. 

A message will appear showing if the shortcut was created successfully or not.  
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Shortcut documents will be created in the destination document. 

 

2.7.8.19 SEND BY EMAIL 

To send a document by mail, the user must simply select one or more documents then click on Send by Email 

button   in the document menu. 

 

The following page will open. 

 
 
The user must enter the Email addresses and the subject of the email, and then choose to send the selected 

files as Links or as Attachments and finally click Send. 

 

2.7.8.20 WORKBOOK TRANSFORM 

A Workbook is a file that contains other documents. To create a new workbook, the user selects Workbook 

→ Transform  in the document’s context menu.  

The selected document will be transformed to a workbook and will appear in the document grid with the 

following icon  

The user can add documents to the created Workbook either by importing existing documents or by 

uploading new ones.  

The user must:  

1. Select the document then click on Workbook → Mark To Import

 in the document’s right click menu. The following 

message will appear showing that the document is marked.  
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2. Open the Workbook by clicking on Workbook → Open  

in the workbook’s right click menu. The workbook will open showing all documents.  

 
  

2.7.8.20.1 IMPORT DOCUMENT 

To import an existing document, the user must click on import . The list of documents marked to 

import will open. 

 

 

The user selects the documents to import then click on . The selected document will be imported 

to the workbook.  

 

2.7.8.20.2 UPLOAD DOCUMENT  

To upload a new document, the user must click on upload . The following page will open allowing 

the user to upload a new document.  

 

 
 

The user must browse for the document then click submit  and the uploaded document will be 

added to the workbook.  
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2.7.9 OPENING A DOCUMENT  

To open a document, the user must click on the correspondent link.  

The user is prompted to choose a mode to open the selected document (Read Only or Edit). 

 

 
 

2.8 ADVANCED IMAGING SERVICES 

To open the selected File in the Image Viewer, the user must click on Image Viewer .  

 

 
 

2.8.1 MENU BAR 

 
 
The Menu Bar allows Users to interact with the following Image Manipulation Operations: 

• Brightness 

• Contrast 

• Saturation 

• Dilatation 

• Invert 

• Flip 
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• Reverse 

• Resize 

• Show Pan 

• View Annotations 

• Save Changes 

 

For example, when the user clicks on Contrast Menu Bar button, the following page opens. The user must 

change the percentage then press OK and the image contrast will change.  

 

 
 

2.8.2 TOOLS BAR 

 
 
The Tools Bar allows Users to interact with the following image processing and enhancement operations:  

• Full Screen  

• Copy  

• Print 

• Rotate  

• Scale 

• Add Annotations (lines, notes, stamps, highlight, audio, video, text…)   

• Other …  

 

N.B: Before adding annotations the User must choose if he needs the annotations to be Private (can be only 

viewed by the User) or Public (can be viewed by other Users of the System). 
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2.9 VIEW MENU 

 

The menu “View” visible in the user Top Navigation Menu allows the user to manage Favorites/Saved 

Queries/Recent Documenats. 

 
 

2.9.1 FAVORITES 

To view his favorite documents/folders/cabinets, the user must click on Favorites button 

 in View menu. The Favorites tab will open in the Navigation Pane.  
 

 
 

Once the user right clicks Favorites node,  he will be able to add folders to 

organize the tree.  

Right click the favorite folder and/or cabinet:  

 

 Click on to delete the selected folder or cabinet. 

 Click on  to view the correspondent documents. 

 Click on to go to the favorite folder or cabinet in the tree.  
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2.9.2 SAVED QUERIES 

To view the saved queries, the user must click on Saved Queries button  in View 

menu. The Saved Queries tab will open in the Navigation Frame. 

 

 
 

The saved queries will be sorted by search types (Content Search queries, Expert Search queries)   

 

Once the user right clicks on a Saved Query, he will be able to delete or view its correspondent queries.   

  

2.9.3 RECENT DOCUMENTS  

To view his recently added or edited documents, the user must click on Recent Documents button 

 in View menu. 

 

 
 
 

To open a recent document, the user must click on the correspondent link.  
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2.10 SEARCH 

The menu “Search” visible in the user Top Navigation Menu allows the user to execute the following types of 

search: 

 Folder Search: Search for Folders within a Folder or Cabinet. 

 Expert Search: Search documents using content types and attributes.  

 Content Search: Search the content of the files. 

 Content Type Search: Search for documents or folders by content type 

 Generate Solo Search: Search the content of the files in the generated zipped folder.  

 

2.10.1 FOLDER SEARCH  

 

Already explained in section 2.2.3.1 “Folder Search” 

 

2.10.2 EXPERT SEARCH 

The user selects a cabinet or a folder then clicks on Expert Search button  in the Search 

menu and the following search screen will open. 

 

 Search in folder and subfolders: if checked, the user will be able to search in folders and subfolders of 

the selected item, and only content types set as visible will appear in content type restrictions.  

 Include children content types in search results: if checked, it allows the user to search in the 

children of the selected content type. 

The advanced layout of this section provides the user with many different ways of searching: by 

content type, by name, by type, etc… 

When the user selects a content type, the other search attributes will be filtered accordingly.  
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 To save the search query, the user must click on the save icon , and the following 

page will open.  

 
 

The user must enter the title for the query then click OK. The chosen query will be added to the 

Saved Queries. 

 To perform the search, the user clicks the “Search” button  on the toolbar, and the 

results will be listed as shown in the figure below. 

 
 

Search results will appear as a list of links. The user must click on the correspondent link to view the file or 

click Back to change the Search criteria.  

Right click the document to view the Context Menu. Each action in the context menu is already explained in 

section 2.7.9 Document Services. 

 

2.10.2.1 SITE EXPERT SEARCH 

Site Expert Search searches documents using content types and attributes within the Site scope. 

The user selects the root then clicks on Expert Search button  in the Search menu and the 

following search screen will open. 
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The manipulation is the same as explained above in Expert Search. The only exception is that the system will 

search automatically in folders and subfolders.  

 

2.10.3 CONTENT SEARCH 

The user selects a cabinet or a folder then clicks on Content Search button  in the Search 

menu and the search screen will open. 

 

 
 

In order to search in folders and subfolders of the selected item, the user must check Search in folder and 

subfolders checkbox. 

 

The user must enter the search criteria. He can use document properties for more advanced search, or click 

Add Properties to use more than one property in the search criteria.  
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 To save the search query, the user must click on the save icon , and the following page will 

open.  

 

 
 
 

The user must enter the title for the query then click OK. The chosen query will be added to the Saved 

Queries. 

 

 To perform the search, the user clicks the “Search” button  on the toolbar, and the results 

will be listed as shown in the figure below.  

 

 
 
Search results will appear as a list of links. The user must click on the correspondent link to view the file or 

click Back to change the Search criteria.  

Right click the document to view the Context Menu. Each action in the context menu is already explained in 

section 2.7.9 Document Services. 

 

 

2.10.3.1 SITE CONTENT SEARCH 

Site Content Search searches the content of the files within the Site scope. 

The user selects the root then clicks on Content Search button  in the Search menu and 

the following search screen will open. 
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To search in subsites, the user must check Search in subsites checkbox.  

The manipulation is the same as explained above in Content Search. The only exception is that the system 

will search automatically in folders and subfolders.  

 
 

In search results, documents from the main site will appear as a list of links. The user must click on the 

correspondent link to view the file or click Back to change the Search criteria.  

Right click the document to view the Context Menu. Each action in the context menu is already explained in 

section 2.7.9 Document Services. 

Whereas, documents from sub sites will not appear as links. Then the user will not be able to view the files. 

He will only be able to view its Properties through the right click menu.   
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2.10.4 CONTENT  TYPE SEARCH 

Once the user clicks on Content Type Search button  in the Search menu, the following 

tree will open in the navigation pane. 

 
 

The user navigates throughout the Content Type Search tree and selects a specific content type to search for 

folders or documents. The user must:  

1. Select a Web application 

2. Select a Site Collection  

3. Select a site or a sub site  

4. Select a content type group (Document Content Types, Folder Content Types…) 

5. Select a parent Content Type  

6. Select a field to search accordingly  

 
 

 To view all documents having the selected content type, the user right clicks a content type

then click on Show All Documents. The following page will open.  
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The user can only view documents by clicking on the correspondent link.  

 

 To search for documents according to the selected field, the user right clicks a field

 then click on Find Documents button. The following page will open.  

 
 

The user enters his search criteria then click on  button. The results will be listed as shown below.  

 
 

The user can only view documents by clicking on the correspondent link.  

 

2.10.5 GENERATE SOLO - SEARCH 

Generate Solo Search will be explained in details further in the Manual Course.  

Refer to section 2.12.2 Generate Solo for detailed instructions.  
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2.11 TOOLS MENU 

 

The menu “Tools” visible in the user Top Navigation Menu allows the user to manage tools:  

 

This menu is divided into the following sub-menus:  

 Audit Trail 

 Alert Me 

 Discussion 

 Workflow 

2.11.1 AUDIT TRAIL 

To view the Audit Trail of a selected Cabinet, Folder or Document, the user selects a folder or a cabinet from 

the tree or a document from the grid then clicks the “Audit Trail” button in the tools 

menu. He/she will be presented with a new window showing the audit trail in the selected cabinet, folder or 

document as shown below. 
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This grid displays the modifications that occurred on the selected cabinet and its documents or the selected 

folder and its documents or the selected document (including routes in all cases). 

The upper frame of the window allows the user to filter Audit results according to the criteria entered. 

Routes will appear in filter results only when the Action Type is Route Actions. 

 

2.11.2 ALERT ME 

The user selects a cabinet/folder/document(s) then clicks on Alert Me button  in the 

Tools menu. The following page will open allowing him to add/edit/delete an e-mail alert notifying him when 

changes occur to the selected cabinet/folder/document(s).  

 

The user Alerts will be listed in a grid, in the bottom of the page. 

 

Created Alerts could be assigned either to the connected user (creator) or to any other user.  

 

 
 

 

 To add a new Alert, The user simply needs to fill in the input fields and then click the “Submit” button

. 
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 To edit an Alert, the user simply selects the record he/she wants to edit then click on the Edit button 

 listed on the same row as the target Alert. The screen will show the same fields used for 

insertion, but this time they will be filled with their existing values. The user must make the necessary 

changes then click on Submit button . 

 To delete an Alert, user must click on the Delete button  listed on the same row as the 

target Alert. The Alert will be immediately deleted and removed from the alerts list. 

 

2.11.3 DISCUSSION 

To create a new Workspace for a selected document, the user must select a folder or a cabinet then click on 

Discussion button  in Tools menu. The following page will open:  

 

 
 

A New Document Workspace (Site) will be created for the selected Document.  
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The user can use this document Workspace to work on documents with other members of the site. Use the 

tasks list to assign and manage tasks. Upload files to the Shared cabinets to share them with others. Use the 

Links list to create shortcuts to files or web sites related to his work.   

 

2.11.4 WORKFLOW 

To start a new workflow on the selected document or to view a running or completed workflow, click on

, the following page will open:  

 
 

The user must click on Approval as shown above to send a document for approval. The following page will 

open.  
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The user must type the names of the people who need to approve on the Approvers line, fill in the needed 

criteria, and then click on Start button to start a workflow.  

A single task will be assigned to each one of the approvers entered. It will appear in “My Tasks”.  

 

2.12 SERVICES MENU 

The menu “Services” visible in the user Top Navigation Menu allows the user to manage services. 

 

This menu is divided into the following sub-menus:  

 Select Pattern: selects a Pattern to be added to Folders or Cabinets. 

 Patterns are folder structures, created by the administrator, which users can select to add 

under a Folder or Cabinet instead of creating the same Folder structure each time. 

 Generate Solo: generates a Document tree of the selected Folder or Cabinet that can be explored 

outside ES-DMS. 

 Export to Excel: displays in an excel sheet a list of all the Documents in the selected Folder or 

Cabinet. 

 Manage Electronic Deposit: used to manage the electronic deposit. 

 Recycle Bin: used to manage deleted items. 

 

2.12.1 SELECT PATTERN  

To select a pattern, the user must select a folder or a cabinet from the tree in the navigation pane, then press 

the Select Pattern in Services menu, and the following page will open. The user will be presented with a new 

form allowing him to select a pattern as shown below. 
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The user must select a pattern then click Select , and the selected pattern will appear in the right 

pane. 

  

2.12.2 GENERATE SOLO 

 

Generate Solo will export the selected Folder or Cabinet with all it subfolders and files to a Zip Folder on a 

specified location.  

You can explore and search the contents of the exported zipped Folder without the use of the ES-DMS 

application. 

Users will be able to: 

 Explore the Folder, its subfolders and files from any browser without ES-DMS being installed. 

 Search the contents of the Folder’s files. 

The user selects a folder or a cabinet then clicks on Generate Solo button  in the services 

menu. The following page will open 

 

 
 
 

The user must click Save, to save the Zip Folder in a specified location. 

In addition to all the subfolders and files contained in the zipped folder, there is an Index.html file . 

 

Once the user clicks on it the following page will open.  
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The Project Tree View will appear in the same structure as in the ES-DMS Tree View Frame. 

 

The Search Option allows the user to search the content of the Files. The user must enter his search criteria 

then click on Search button. The search results will appear in Search frame as a list of links.  

 

Search results are files that contain the Search Keyword in their title or in their content. 

Once the user clicks on the displayed hyperlink, the file will open. 
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2.12.3 EXPORT TO EXCEL 

The user selects a folder or a cabinet then clicks on “Export to Excel” button  in Services 

menu. The following page will open. 

 

 
 
 

The Excel File displays a list of all the documents of the selected Folder or Cabinet: 

 Columns 

• Name: the name of the document 

• Modified: date of the last modification 

• Modified By: the user that did the last modification 

• Item Type: document type 

• Path: document path in the Tree View 

 Rows 

• Selected Cabinet or Folder 

• All Subfolders 

• Documents of the Folders and Subfolders 

 

 
 
 

The user must click on the correspondent link to open the Document, Folder or Cabinet.  
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2.12.4 MANAGE ELECTRONIC DEPOSIT 

The user selects a folder or a cabinet then clicks on “Manage Electronic Deposit” button 

 in Services menu. The following page will open allowing him to manage his 

electronic deposit.  

 
 
This page allows the user to delete documents, and\or send documents by mail.  

To send a document by mail, the user must select a document then click on  button. Following page 
will open. 
 

 
 
The user must enter the Email addresses and the subject of the email, and then choose to send the selected 
files as: 

o Attachments or Zip and Attach: the document will be sent as attachment along with the link in the 
email body 

o Link: the document will be sent as link in the mail body  

Upon clicking on Send the following confirmation message will open asking the user if he wants to save the 
mail he just sent.  
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In case the user wants to save the mail, the following window will open showing the destinations to save the 
mail. 
 

 
 
The user must select a destination folder of cabinet then click on submit to save the mail.  
 
 

2.12.5 RECYCLE BIN 

 Any Content Object deleted by users will not be entirely deleted from the system; it will be 
marked for deletion inside the Solution’s Recycle Bin. 

 The Recycle Bin holds all the users’ deleted Items. Only administrators or users with specific 
privileges can access the Recycle Bin. 

 Objects in the Recycle Bin can either be restored to their original location or deleted 
permanently from the system. 

 

 
 

The user will be able to restore items already deleted from the current site. He must select an item 

then click on  button to restore the selected item. 
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To delete an item the user must click on . Items that were deleted more than 30 
days ago will be automatically emptied.  
 
To manage deleted items for the entire Site Collection click on the following page 
will open showing the deleted items of the whole site collection.  
 

 
 
The user selects an item(s) the click on: 

  to restore the selected item in its original location. 

  to delete the selected item 

  to empty the whole recycle bin 

  to go back to the previous page 

The user will be able to restore deleted items, delete items and empty recycle bin. 
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3. ENABLING 

3.1 CLIENT INTEGRATION APPLICATION 
 
The ES-DES Integrator application is a small application that will be installed on client machine to 
enable the identification of application and text highlighting by users.  
The user will be able to select a text from an application UI and press a predefined shortcut key on 
his keyboard in order for the client integration application to identify the required information and 
open an Internet Explorer instance displaying the Document Enabling Services; ES-DES Document 
Manager. 

The ES-DES Integrator application can be run at windows startup and will be present and visible only in the 

Windows taskbar. The icon  will have a context menu comprising the following menus: 

1. Settings: ES-DES settings (Storage and Application Settings) 

2. Auto start: to disable/enable the application to start on windows startup.  

3. Help: a help document and user guide to use the integration services and their features  

4. About: open the About form. 

5. Exit: allows the user to exit and close the integration application  

 

 
 

3.1.1 SETTINGS 

The settings window is divided into two tabs:  

 Storage Settings: define different storage destination (server on which the ES-DES server 
application is installed) 

 Application Settings: define the process that will activate Document enabling. 
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3.1.1.1 STORAGE SETTINGS  

 

 
The interface above displays the available Storage Settings. It allows the user to add a new storage, 
edit or delete an existing one. 
The name is a description to identify one storage setting from the other; the URL is the server 
name/location where ES-DES server application is installed and running. 
 

3.1.1.2 APPLICATION SETTINGS 

The Application Settings section is where applications can be added to the ES-DES Integrator to 
activate Document Enabling on those applications.  
There is no limitation on the applications that can be added here or the number of applications to 
add. 
Any application installed on the Machine can be added in this section. Each application will have one 
shortcut key assigned to it and one destination storage. 
 

 
 
The interface above displays the different application settings 

Application process: process where the data will be captured from 

The Assigned Shortcut: shortcut used to trigger the capture and send data events 
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Destination: the storage setting associated with the selected process. 

  

 To add a new application, the user must click on  button on top of the window. The 
following Add New Application page will open: 

 
 
The user must follow the following steps: 

1. Browse for a process from the available processes by clicking on  button  

 

2. Select a process then click on OK 

3. Enter the shortcut identifiers of the application (ex: Shift F1, CTRL 3...) 

4. Select the Destination 

5. Click on  to save the application or on  to cancel the operation.  
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 Editing an application is as easy as adding a new one. The user must select an application then click 

on button. The same page will open but this time in edit mode. Add the necessary 

modifications then click on  button to save the changes. 

 To delete an application the user must select the application he wants to delete then click on 

button.  

3.2 ES-DES DOCUMENT MANAGER 

The ES-DES Document Manager is a web form instantiated by the ES-DES Integrator.  

Its main purpose is to validate the information sent against the existing entities, create the 
appropriate filing plan and display the existing documents to the user. It is also the main application 
to add documents and metadata. 
 

When the user activates ES-DES for an application (for example NAV), the client integration application will 

open a new IE instance with the below interface. 

The interface below, will display all integration entities configured in ES-DES Administrator and matching the 

selected criteria (Business application, Business form and Business URL). 

In case only one entity meets the criteria, the window below will be skipped. 

The user will select the desired entity and will be directed to the correct Mapping of documents. 
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Once the user selects a value and initiates DES (through pressing the HotKey), the selected value is 
compared to the Primary Key as defined in Entities – Data tab. 

If the selected value exists only once under either the “Primary Key” then the value is loaded into ES-DES as 

follows: 

ES-DES adds folders as per the filing plan configuration 

Patterns are created beneath the user’s selected value 

 

If the selected value exists multiple times under the “Primary Key” then the value is loaded into ES-DES as 

follows: 

User is prompted to select one record to proceed 

 

ES-DES adds folders as per the filing plan configuration 

Patterns are created beneath the user’s selected value 
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If the selected value does not exist under the “Primary Key” then the value is loaded into ES-DES as follows: 

User is prompted whether to continue with the folder creation operation 

 

ES-DES adds a new Folder using the user selected text 
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3.3 DMS INTEGRATION FORM (SINGLE ENTITY) 
The user selects a text from an application (NAV for example) and press the combinations already 
defined in Hot Keys, the system will redirect him to DMS integration form. 
 

 
 
Whenever the user selects the data entity desired, the system will redirect him to the DMS 
integration interface shown in the figure below.  
The system will check if a folder already exists for the selected value. If yes, the system will display 
the folder and subfolders.  
If the folder is not available, then the system will create it and check if a pattern is assigned to the 
integration entity. If yes, it will create the pattern under the created folder.  
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3.4 ES-DES DOCUMENT MANAGER 
To access ES-DES Document Manager, go to the SharePoint website, Site Settings and hit ES-DES 
Viewer 
 

 
 
ES-DES Document Manager enables the user to access, modify and upload documents to the system 
via ES-DES. 
 

 
 

3.4.1 MAPPING 

In case of content type mapping, and when adding file, adding multiple, scanning and adding new, 
the content type properties will be automatically filled depending on the value of the primary key in 
the entity. Mapped columns will appear in read only, since these values are retrieved from the 
database, as shown in the figure below  
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3.5 IMPORT SERVICE 
 
The ES-DES Import Service requires the user to paste files into a shared directory on the SharePoint 
Server. 
 
The file must follow a specific naming structure: 
Entity_PrimaryKey_ContentType_FileName 
 
Entity: Entity Name from ES-DES settings 
Primary Key: Primary key from Navision 
Content Type Name: Content Type of the document 
File Name: Filename to be used in SharePoint. 
 
 
Once pasted, the ES-DES Import Service automatically uploads the file into ES-DES 
If the Filing Plan is not created, ES-DES Import Service creates the filing plan as per the Entity and 
the provided primary key. 
The file is uploaded to the Filing Plan and file properties are automatically mapped with their target 
data. 
 


